Corridors

To create a corridor you must have an alignment (baseline), a profile (existing or proposed), and an assembly.

Alignments

You have 2 choices in defining an alignment: (1) Alignments > Create Alignment By Layout (Alignment
Creation Tools on the ribbon), or (2) Alignments > Create Alignment From Objects.

Create by layout gives you the constrained based design options.

GLOGEE Insert  Annotate  Modify  Analyze  View Output  Manage ExpressTools  Imagel
x £ Import survey Data | &) Parcel ~ +=% plignment ~| = Intersection i 1
. B4 .
Paints - Feature Line | 43—
Toolspace ﬁ dﬁ " "'; saturs Hn ' l‘; Alignment Creation Tools
ﬁ? Surfaces = @* Grading = =
Palettes - Create Ground Data -

o) ¥ ) B

=i~ Create Alignment from Chjects
i

m&_l_r\ Create Alignment from Corridor

6\/ Create Alignment from Network Parts
=,

J Create Offsat Alionment

2+ Create widerin
c a

Constrained based design will maintain

tangency based on 3 choices:

1. Fixed curve - These commands are similar to an AutoCAD arc, but have a third point along the arc.

Alignment Layout Tools - Alignment - (1)

Av BANA | /v @) Ky O~ A2 | OARPE & @
Select a command From the layout td =, ¥ Fixed Curve { Three point ) |
Iore Fixed Curves h Fixed Curve { Two points and direction at first poink )
:2. Fixed Curve - Best Fit {"E Fixed Curve { Two points and direction at second point )
&% Fived Curve { Two points and radius
5 Floating Curve { From entity, radius, through point ) ¢ & )
ifs
) #7n Fixed Curve { From entity end, through paoint )
Mare Floating Curves 4
o . ) @ Fixed Curve { Center point and radius )
o Floating Curve - Best Fit {
G) Fixed Curve { Center point, through paoint )
“F* Fres Curve Fillet { Bebween bwo entities, radius ) T Fixed Curve ( Through point, direction at point and radius )
=S

Free Curve Fillet { Between two entities, through paint )

Free Curve - Best Fit

Floating Curve — Maintain tangency at the start, while one end is not connected to another object. For

example, curves off the end of a line.

Alignment Layout Tools - Alignment - {1)

Av B8 | /v [mF]) #v &v 200 A2

Select a command From the layout bc o=, ¥ Fixed Curve { Three point )

Mare Fixed Curves 4
qn Fixed Curve - Best Fit
ﬂ?- Floating Curve { From enkity, radius, through point )

ld = Floating Curve { From entity end, through point )

More Floating Curves

A= Floating Curve - Best Fit =3  Floating Curve { From entity end, radius, length )
Cu " o N - . .
Flaating Curve | From entity, through point, direction at point
e Free Curve Fillet { Between bwo entities, radius ) e 4 ( i ah point, point )
s, Free Curve Fillet { Between bwo entities, through point )
E': Free Curve - Best Fit
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3. Free Curve - These entity types are very similar to the AutoCAD "fillet" command, but give you added
control.

A Free Curve Fillet [ Between bwo entities, radius )

e, Free Curve Fillet { Between bwo entities, through poink )

Alignment Layout Tools - Alignment - {1)

A KL 1A s Y v g Zlox EBARPE| & &

Select a command From thel ~° ¥ Fixed Line { Two paints )

Fixed Line | From curve end, length )
Fixed Line - Best Fit

Floating Line { Fram curve, through point )
Floating Line { Fram curve end, length )

Floating Line - Best Fit

P RS NN

FreeLine { Betwaen bwa curves )

Listing and Labeling off an Alignment

e “Analyze” ribbon tab > Inquiry Tool — Once in the inquiry tool, there are 4 pre-defined listing
commands to obtain information from an alignment.

B

----- 3 alignment Station and OFfset at Paoink
----- *% Alignment Skation, Offset, & Prafile Elevation at Point
----- *% Alignment Skation, Offset, & Surface Elevation at Point
Ly Alignment Twao Skations and Offsets at Poink

e “Annotate” ribbon tab > Add Labels > Alignment > Add Alignment Labels — This command may
add labels to offset stations as well as alignment segments.

Feature:

Alignment w
Label bype:

Skation Offset - Fixed Poink w

Skation Offset - Fixed Paint

Station Offset

Single Segment LF'Q
Multiple Seqrment

Tangenk Inkersection

Multiple Tangent Intersection
E_“‘ Dpd {184 Lr:lgL'II:" T il Lﬁ'

Reference text object prampt method:

Command Line w

Add ] [ Close ] [ Help
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Existing/Proposed Profiles and Profile Views

1. “Home” ribbon tab > Profile > Create Surface Profile

22 Create Profile from Surface

Aligriment: Select surfaces:
oL v m‘\ ‘
Skation range - - -
r— Highlight the surface you wish
- e to sample, edit the station
i e range if desired, and then
(o000 | [15+99.6 | click the ADD button.
Ta s|amp|e: | | | = [15ample offsets:
1-+00.00° || 15+99.66 R
Profile list:
Station Ele
Mame Description Type Data So... Offset Update ... Layer Style g
Start Ern M.
QG - Sur...| \—'_" o] 0.000" D\y'namiE C-ROAD-... Existing ... 1400.00° 15+99.66' 157.
Change parameters if desired.
< l >
[ Drraw in profile view ] [ ok ] [ Cancel ] [ Help
)

2. “Home” ribbon tab > Profile View > Create Profile View

A Create Profile View - General

} General Select alignment:
[Tpo v|

Profile view name:

Station Range

Prafile Yigw Height | Z[Parent AlignmentiCP]=-py |
Profile Display Cptions Description:

Pipe Nebwark Display. | ‘

Data Bands Prafile view skyle:

iy Full Girid v| B[~

Prafile view layer:
| C-ROAD-PROF-YIEW |

[Ishaw offset profiles by vertically stacking prafile views

Profile Hatch Options

MNavigate each station to
determine the desired seftings.

< E-a-:}mext> ] [ Create Profile View ] [ Cancel ] [ Help ]

A
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3. Profiles > Create Profile By Layout

Constraint based
design. Similar to
alignment contraints.

Draw tangents with

Other PV edit
no constraints

commands.

Mofile Layort Tonls - FiG

and From the layout Eools

7 /

Undo and Redo

/

PVI edit commands Convert AutoCAD

- Listing commands.
entities.

4. Profile View Properties, “Bands” tab, Set “Profile 2” to the design profile. (If you use a band style with
FG and EG elevations.)

3 Profile View Properties - CL-PY M=1E3
Information | Stations | Elevations | Profiles | Bands |Hatch
Band type: Select band style:
|Pr0FiIe Data v| E Cut Data vl @ - Add=>
List of bands
Locakion:
|Bott0m of profile view v |
P Show La... Major In... Minor In... Geometr... Label Sk...  Label En... Alignment  Profilel Profile2 Weeding | Stagger ... Stagger ...
oo’ | | | | ) Y o |oG - Surf...| 66 - Surface (17 2_|Staggert...|o.0o00"
O - Surface ili
< =
[#]Match major/minor increments ko vertical grid inkervals Import band set. .. ] ’ Save as band set... ]
Ok ] [ Cancel ] [ Apply ] [ Help ]

Listing and Labeling Profiles and Profile Views

ERA P ofile view

ol Profile Wiew Skation & Elevation at Poink

E bel Profile iew Elevation & Grade between Points
Ellﬁ Prafile

fsl Profile Skation 2 Elewvation at Poink
------ tsl Profile Elewvation Difference at Stakion

“Annotate” ribbon tab > All Labels > Profile View > Add Profile View Labels
http://www.cadmasters.com/c3d_cheatsheets.html

“Analyze” ribbon tab > Inquiry Tool — There are several listing commands for profiles and profile
views.



Create/Edit Assemblies

1. “Home” ribbon tab > Assembly > Create Assembly — Choose the appropriate styles and place the
baseline somewhere in the drawing.

The horizontal
alignment and
profile will follow
E this point.

S P— P
K Imperial Basic Subassemblies g
i e
. . W Basiclane u
2. Corridors > Subassembly Tool Palettes — This & BasicLaneTransion E
displays the tool palettes that contain pre-defined sub- 8 GenericPavementStructure le
assemblies to be placed on the assembly. o | @shwetispezoi |5
E "% BasicShoulder _
§ \BasicCurb E
E s BasicCurbAndGutker %
§ A~ BasicSideSlopeCutDitch =
-E ™y Basicisuardrail E
ué' A BasicSidewalk. i
E _lBasicBarrier E
; * SimpleMaiseBarrier E!
_::fa Imperial Basic Subassemblies E

L+l
e

No selection

a. Find the desired
subassembly, left click
the tool, fill out the
properties, and then
choose the attachment
point on the assembly.

>

E =
l Display J_Ob]ect LExtend... L Design

Parameters
ersion R2007
Side Right
Defaulk Width 8.000'
Depth 0,330
Default Slope -2.00%:
Transition Hold grade, change offset

PROPERTIES

Default Slope of the lane

D

I Fick the attachment point here. /

b. Rename the subassembly to an appropriate name. This will be important later in the definition of
the corridor.
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Create/Edit C

orridors

3. “Home” ribbon tab > Corridor > Create Corridor

a. Choose the horizontal alignment (baseline), then the profile, and finally the assembly.

L2 Create Corridor

Corridor name:

Corridor layver:

X

| Mew Corridar|

| | C-RoAD-CORR.

|

multiple baselies and
muitiple regions to

and one alignment.

define a corridor.

|

I3 Frequency to Apply Assemblies

Froperty
El General

= Apply Assembly
Along tangents
Along curves
Along spirals
Along profile curves
At horizontal geometry points
At superelevation critical poi. ..
Af profile geometry poinks
Ak Profile High/Low points

Yalue

Any particular region must have an
assembly attached with the correct
station range. This allows the user
to have one baseline with many
different regions denoting changes
in the road geometry throughout the
alignment stationing.

amount of sections
sampled in any particular
region. Only add section
where you absolutly need
them, making the corridor
as fast as possible.

Description; Corridor style:
| | FE‘E B asic: i | L] = @
[ Add Baseline ] [ Set all Targets ]
Tame Alignment Profile Assembly Start Station . End Station . Frequency . Target Cweerrides
2 ep” BL-CL-(1) L Fi ____———TFmm — e ;
$ RG - Primary Roa... \ f (Primary Road Full,.,  1+00.00' Eli 15+99.66' 5,000 f [
Y llowed St DA EHE e This allows youto
ou are allowe: only follow one profile Frequency defined the y

attach surfaces
(Daylight
subassemblies) and
alignments/profiles/
polylines to other
subassemblies.

LA Target Mapping

Cortidor narme:

ar {11

Assembly name:

Choose the surface

Start Station:

MNaming the subassemblies
| becomes extremely important
here, making sure you attach to

Primary Road Full Section to daylight to. | [1+00.00 the correct subassembly.
Target Object Name Subassembly / Assembly Group
[=- Surfaces lick. here to set all= &
Target Surface <Mone = EasicSideSlopeCy h - Right | Right
Target Surface <Mone = EasicSideSlopeCutDitch - Left | Left
25,000 = ‘Width or Offset Targets
25.000 ‘width Alignment <Mone = LaneCutsideSuper - Right Right
25.000¢ ‘width Alignment <Mone = LaneCutsideSuper - Left Left
biEs = Slope or Elevation Targets
S CQutside Elevation Profile <Mone = LaneCutsideSuper - Right Right
::: CQutside Elevation Prr\ <Mone = LaneCutsideSuper - Left Left

M— Add user defined stations here

Station

3+82.87'
5+19.09'

Description

End Transition

N

Depending on the subassemblies chosen, you can
attach alignment/profiles/polylines to stretch the
assemblies to the desired configuration.

x|

Cancel ] [ Help

[ o ]

Cancel

] ’ Help
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4. Create Corridor Surfaces (Within Corridor Properties)
Surfaces can be used to create the finished surface as well as calculate volumes. Typically, the top
surface will become the finished ground surface while the datum surface will become the volume
calculation surface. See the manual for further detail.

R Corridor Properties - New Corridor [z|

|InF0rmation ||Parameters | Codss | Featurs Lines |Surfaces |Boundaries |

Create a corridor surface

Specify cade:

|+j Feature Lines v| |Top_Curb v| [E

Mame Surface Style Render Material Add as Breakline Owerhang Correction Descriftion

= v Contours 1' and 5' {Design) i = Top Links

El_'l L¢ Top
F

7 packCu This button will add date to the highlighted

«JP Daylight surface. Choose either links and/or feature

A7 DitchIn lines to add to the surface. Notice | added

A7 pitch_ou all the appropriate data for the road to

A7 Emw ‘\ generate the top surface. | would choose

A7 Flange l other data to add to the datum surface.

7 Flowlne_cutter These names are derived

T w - from the subassemblies

T ngec ) used in the corridor.

op_Cur
A3 >

[ [o]4 ] [ Cancel ] [ Apply ] [ Help

5. Add a Boundary to the Corridor Surface

L2 Corridor Properties - New Corridon

|InF0rmati0n ||Parameters ||Codes ||Feature Lines || surfaces |Boundaries |Slope Patterns |

ame Description Render Material Definitions Use Tvpe

w” [ A

Add Automatically Back_Curb

Add Inkeractively. ..

Add From Polygon...

Daylight_Cut
Daylight_Fill
Ditch_In
Ditch_tut
Refresh ETW

Copy walue to clipboard

Copy to clipboard For simple corridors you will have the option to choose a boundary

automatically, usually the daylight feature line. Mon-simple corridors,
yoll can use the shrinkwrap option {not displayed here) or the
interactive option that lets you trace the feature lines manually.

ETW _Base
ETW_Pawvel
ETW_Pavez
ETW_Sub

Flange

Flowline_Gutter
Hinge
Hinge_Cut

Hinge_Fill
Top_tCurh

[e]'4 ] [ Cancel ] [ Apply ] [ Help ]
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Sections

Sections are used for 2 things: (1) Plotting sections at desired stations, and (2) Calculating the volumes from a
corridor. To accomplish the later, you must have added a corridor surface to represent the datum surface before
sampling the sections.

1. “Home” ribbon tab > Sample Lines

LA Create Sample Line Group gl
Tame: Sample line skyle:
| CL Callection - <[Mext Counker{CP}]= | __E‘ Road Sample Line V| I_?? bl
Description: Sample line label style:
@'E‘ Section Marme V| W
Sample line layer:
A= | C-ROAD-SAMP : . : |
o Choose the data to include in the sample lines.
Make sure you choose the datum surface so
Select data sources ka sample: you can perform an earthworks calculation later.
Tvpe Data Source Sample e Section [ayer Update Mode
QG Exisking around C-ROAD-SCTN Dvyniamic
Mesw Carridor Basic C-ROAD-5CTH Dwniamic
Tevs Corridor Top Exisking round C-ROAD-5CTN Crvniamic
T Corridor Dakum Exisking round C-ROAD-5CTN Crvniamic
I [al'd ] l Cancel ] l Help ]

Next to appear is the “Sample Line Tools” dialog box. See below for further explanation.

Sample Line Tools

|[Sample Lire Station Yalue]:= | '—E‘ :[2} |[‘_"J] 5L Callection v| [[Lﬁ "] [;’( '] ;ﬁ @ =)=

|Current method; By stations Alignment name: CL )FE( By range of stations. ..
S ¥ Bt a Station

rﬂ Frorn corvidor stations

1

.[;3 Pick points on screen

HE Select existing polvlines
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Calculate VVolumes

There are two (2) types of volumes you can extract from a corridor: (1) cut and fill; (2) quantity of material.
Cut and Fill

After creating the datum surface in corridor properties, you can simply use the volume calculator to see the
volumes.

“Analyze” ribbon tab > VVolumes > Volumes

=
e Re
Surface Pair Yolume
Index
Base Surface | Comparison Surface Cut Fill et | Met Graph

arridor - Datum 1570 Cu, vd, 91 cu. vd, [1778 Cu vdo<cut= oo |

Calculating volumes based on station ranges. (Cut and Fill)

1. “Analyze” ribbon tab > Compute Materials

X

2 Compute Materials - SL Collection - 1

Quantity takeoff criteria:

@% Earthworks v |

Curve correction tolerance | 1.0000 (d) | [ Map objects with same name

Mame in Criteria Ohject Mame IMaterial Mame

=] ﬁ,ha Surfaces
ﬁh/ Existing Ground oG Earthworks

) ot e

Erﬂj Corridar Shapes

2. “Analyze” ribbon tab > Volume Report

2 Report Quantities [‘5__<|
Select alignment:
[ ¥
Select sample line group:
|[__')] 5L Collection - 1 v |
Select material lisk:
[Material List - (1) v|

Select a style sheet:
| CHiDacuments and Settingsi Al Users) sprp |

[ Display =ML repart:

[ (814 l ’ Cancel ] [ Help ]

http://www.cadmasters.com/c3d_cheatsheets.html



Calculating volumes based on station ranges. (Quantity of Material)

1. *“Analyze” ribbon tab > Compute Materials

22 Edit Material List - SL Collection - 1

[ Add new material

{

Define material

Data bype:

Select corridor shape:

e Carridor Curb b

(%]

]

|EL|—_J] Carridor Shape v
Use this for each material | Hew Corridor Pavel
. you wish to add - . Mew Corr!dor Pavez
IMaterial n Quantity Type Cut Fackor Fill FaciMew Cortidar Base e Tolerance
— Mew Corridor SubBase
=2 Material List - (1) Mew Carridar Curb 0000 {d)

=] Earthwvorks Earthwarks 1.000 1.000 1,000 * Basic

@ Qi Base

@ MNew Corridor Datum Compare \
=8 Ac Structures 1.000 :

IE!EEJ Mew Corridor Pavel  Include This listis Obtamed

E!L—:-'J Mew Corridor Pavez  Include from the assembh_es
&5 a8 e = attached to the corridor.

E!L—:-'J Mew Corridor Base Include

E!L—EJ Mew Corridor SubBase  Include
= Curb Struckures 1.000 Basic

E!L—EJ MNew Corridor Curb Include \

Make sure this is
sef to structures.
[ Import another criceria
[ [o]'4 ] [ Cancel ] [ Apply ] [ Help

]

2. “Analyze” ribbon tab > Volume Report

LA Report Quantities

Select alignment:

X

[Tl

v| B

Seleck sample line group;

(2] 5L Collection - 1

v| B

Select material list:

| Material List - (1)

vl

Select a style sheet:

| port Style Syf=s

Select Material xs| |

[oisplay =ML repart

| ok

H Cancel l/y Help ]

select material.xsl

Use this button to change to the
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